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Advanced Excel 2010

What’s new in Excel 2010 Intro

Customizable ribbon " ‘T|
Office Backstage View ; .
Workbook management tools .
Sparkline’s

Slicers

Paste with Live Preview

New Equation editing tools

Many other enhancements

TIP See these resources:
What's New in Excel 2010;

it I-help/wh i 1

2CTT:

Guide to locate favorite menu and toolbar commands in 2010 Ribbon;

ft, help/l Ib: ds-are-i d-rel.
products-HA101794130.aspx#_Toc268688375
W
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Advanced Excel 2010

» Power user Tips and Tricks
* Master the Data
 It’s all about the Data
« Data tools to manage the Data
» Transform the Data
» Automate - adopt Developer skills
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| Power user Tips & Tricks |

¢ Quick Access Tool bar and Ribbon -
customize
The ribbon new to Excel 2007 allowed
users to Customize quick access toolbar

» New to Excel 2010 customize Ribbon

Create custom tabs and groups and
rename or change the order of the built-in
tabs and groups.

TIP You can also get to the Customize the Ribbon window, by right-clicking any
tab on the ribbon, and then clicking Customize the Ribbon.
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Power user Tips & Tricks

Customize
options

Excel 2010 customize Ribbon sic e options\ciick customize ribbon

New Tab

New Group
Rename
Import/Export

Rearrange with

up and down
arrows
TIP See this resource
Video: How to customize the Ribbon;
ice.microsoft. Jexcel-help/vid: - ethe-ribb,
HA101850352.a5px?CTT=5&o0rigin=HA010355697
Advanced Excel 2010 iy

Power user Tips & Tricks

» Templates - save time and add i to your excel
File Tab\New
templates grouped by categories

A powerful dashboard template is one of the many options available
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Power user Tips & Tricks B ==

» Status Bar - get more information
Customize the status bar - right-click status bar

» Freeze and unfreeze worksheet titles - view titles while scrolling
through large data sets
View tab\ Freeze Panes (Unfreeze Panes)

Excel displays dark ines to indicate frozen elements.

» Split and Un-split Worksheet windows a toggle command,
allows users to scroll and view sections of large data sets.

View tab\Split —toggle on and off. s E
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Power user Tips and Tricks
B) View Side by Side
Line up Multiple Sheets in the same Worksheet in same window
View tab\New Window\View Side by Side
By default, Synchronous Scrolling option is turned on, so that you can scroll
through both pages by dragging the slider bar in one of them.
Turn off Synchronous Scrolling if you prefer to scroll through each sheet

separately. D—————
s ma-C==1 3

» Magnification - Zoom slider allows user to view more data on the screen. Click Zoom
slider bar to desired magnification

To focus on specific group of cells or data, select data set, than
slide Zoom Slider

Zoom dialog box; allows user to define zoom ration
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| Power user Tips and Tricks
‘ Keyboard shortcuts — adding a few of these can be a huge time saver
CTRL key shortcuts
ALT key shortcuts — and Hot Keys for editing commands
Press ALT key - KeyTips displayed over each feature that is available in the current view.
My new favorite ALT = =SUM() function XTI -

KeyTips

CNTL-[: - CTNL than keys — [ at the same time-
highlights the Formulas that -Reference the Current Cell Excel 2010 Keyboard shortcuts
Function keys- F1-F12

‘ F1= help; F7 spelling; F9 calculate; F10 KeyTips; F11 create chart current cell range; F12

Save As

TIP See these resources:

Excel 2010 Keyboard Shortcuts including PDF Quick Reference Cards; icrosoft.com/en-
us/excel he in-excel-2010- ice.microsoft.com/en-
us/excel he in-excel-201 #BM3

Excel 2010 keyboard shortcuts II: ALT key Course & Quick Reference Card; http://office.microsoft.com/en-
I-help/excel-2010-keyboard-sh ii-alt-key-sh 102733786,

Excel 2010 ALT hot keys for editing commands;
http: dummi h Keys-f I

ds.html




Advanced Excel 2010 o |

Power user Tips and Tricks

- New Backstage view & File Tab - where you do things to the file which you don't do in the file
Replaces File menu or Office button in earlier versions

Contains common tasks related to files

’w The Office Backstage view is
where you manage your files
and the data about them —
creating, saving, inspecting for
hidden metadata or personal
information, and setting
options.

Backstage view - simplified
printing (Ctrl+P)- preview,
change settings, and print all
with a live preview
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Power user Tips and Tricks
» Excel 2010 Security — Protect your files

Protected view and more!

Security Message Bars provide the opportunity to consider
the potential security risks that may be in your file, and then the
ability to open or read the file while reducing the risks that can
occur.

Use the Trust Center to view security settings or to change
them. File Tab/Help- Options/Trust center

Understand the reasons for Protected View and how to
enable editing when it appears.

TIP See this resource

Quick Reference Card: Office 2010 Security Protecting your files;

http://office.microsoft.com/en-us/word-help/quick-reference-card-
RZ101665538.aspx?section=10&mode=print
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Master the data

Format and edit - Home Tab

- =]
3= R e rEm i ,,

» Transpose — rearrange data in rows and columns
Home tab\Clipboard\Copy\Paste\Transpose
‘ Conditional formatting — visual clues to data
Home tab\Styles\Conditional Formatting
» Format as Table — quickly manage group of related data independently from
data in other rows and columns.
Home tab\Styles\Format as Table
»Cell Styles- quick and easy style changes to cells — more than 40 colorful
predefined styles available

Home tab\Styles\Cell Styles
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Master the data

Visually denote the data- Insert Tab

P Tie arceofoqe raceoat)
= =

In Excel 2010 Chart wizard retired!
Charts > Insert tab = direct access to all major types of charts

Pivot table and Table option — use to quickly arrange, summarize,
manage, and analyze the data

Slicer —filter large data sets in more detail

3 33

Grouping — outline and summarize data up to eight levels.
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Master the data

* Visually denote the data- Insert Tab
» Charts — display data visually
Understand the parts of an excel chart to harness the power
of the visualization.
The guts: Chart area, data marker, data series, axis, tick mark, plot
area, gridlines, chart text, and legend.
Ot Chmt e Do s
[ - =] = ) i
CE- bt ok (B d b

TIP See this resource:

Get to know the Parts of and
Excel 2010 Chart;
http://www.dummies.com/ho
ot 2 e o e w-to/content/getting-to-know-
1 the-parts-of-an-excel-2010-
. 223717.html

b i
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Master the data
» Sparkline’s — visualize data trends with one click e
How to use Sparkline’s to show data trends 5 ;
TIP
How to use Sparkline’s to show data trends; http://office.microsoft.com/en-

I-help/ parklines-to-show-data-trend: o

» Hyperlinks — embed links to documents, email addresses, picture, or
website directly on worksheet.

Embed byperiinks within g worksheet

Wit Legel 2010 Chans - For €
» Screenshot tool - instantly insert picture of any program that is

running and is not minimized. Use screen clipping to insert a part of
the screen picture.
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It’s all about the Data

| T > T

Data tab - get connected
-Get external data — eliminate time consuming copy and paste
Import data from a variety of sources with a few simple clicks
After connection you can auto refresh data from its original source,
manage and change connections and their properties.

Connect to external Data Excel 2010;

03/18/2013

microsoft [en-us/excel-| to-import-external-data-HP010342297.aspx
Advanced Excel 2010 o |

‘ It’s all about the Data

» Connect data (import data) from text files

) A E TR [INCRT—

Advanced Excel 2010 e

It’s all about the Data — get connected

» Existing
s .

Data refreshed
with saved
connection
options

MSN Money
defaults

Use data
connections for
data files,
databases, and
other data
sources
including the
Web.
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‘ Data tools to manage the data

Data Tab — empower yourself

» Sort & Filter - Specify the data you want to see with- you are the master over
the data

» Data validation - control type of data entered into cells; Data tab\data
validation.

03/18/2013
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Data tools to manage the data
Data Tab — empower yourself over the data
Consolidate - summarize and report values from multiple worksheets or workbooks into
one NEW range/worksheet.

Two main techniques: by position; by category
Data Tab/Consolidate

e J ———
Various ) am
functions O "
available e
-
Let’s try!

TIPS Consolidate data from multiple worksheets in a single worksheet
Video: Consolidate Excel Data from multiple workbooks

Advanced Excel 2010

‘ Data tools to manage the data

Data Tab — empower yourself
» What —If Analysis: -test values for the formulas in the sheet

Scenario Manager- Create and save various
scenarios and switch between them £

Goal Seek- find a desired value for a formula-
Data tables -see results of varied possible inputs.

TIPS
Intro to What- if analysis; http://office.microsoft. I-help/ir ion-t
what-if-analysis-HA010243164.aspx

Video: What-if analysis example; http: .youtube. ? iSlw

Compare Budgets with Scenarios;
http://ble i

12009/12, budgets-with-excel
scenarios/
Video: What-If / Data Tables; http:, .youtube. h?v=eSRr3g6ptYY

Let’s Try it!
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Data tools to manage the data
Data Tab — empower yourself

Group and Subtotal - Outline the data up to 8 levels
» Group or relate a range of cells so they can be
collapsed and expanded.
Subtotal total rows of related data together by
automatically adding subtotals and totals for cells selected.
Use an outline to quickly display summary rows or columns,
or to reveal the detail data for each group

How to outline (group) data in a worksheet ;
TIP  http://office.microsoft. I I -data-in-a-worksheet-
'HA010342744.aspx

e Tryit!
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I Transform the data ! |

The Formula tab - take action

I

L IpBBIEEEE I et el I

Function Library

Functions — arranged by categories
Defined names — group data ranges for use in formulas
Formula Auditing -pOwerful tools to manage formulas

Trace Precedents/dependents/remove arrows
Show Formula - a hidden GEM
Error Checking
Evaluate Formula
Watch Window

» Calculation Options

Advanced Excel 2010 iy

[ Transform the data ! |

The Formula tab - take action

L

PE8:6 088

» Insert Function- fx

TIP Use Insert Function option on
the Formula tab to open dialog
box.

For help with functions —
highlight function in blue and
select “Help on the function”

option bottom of screen
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Transform the data ! |

The Formula tab - take action

=

P 9,

Function Library e |
Defined names - simplify data ranges for use in formulas

£, 3 names for Admin, IT, i i i '
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Transform the data ! Formula Tab

» Show Formulas — powerful feature which auto displays all

functions
.J-= IpeRGE DN J = :
HIDDEN ' —

GEM

Calculate Options — specify when functions are calculated, default is
recalculate when formula change made

Advanced Excel 2010 iy

| Transform the data ! |

The Formula tab — take action
Function Library
Evaluate Formula -

Select cell than
evaluate formula
option to get results

Results here

Cell using data
validation and contains
a constant
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\ Transform the data ! \

The Formula tab — take action
Function Library
Watch Window — monitor values of specified cells

03/18/2013
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Transform the data !
Formula Tab

» Rank data with Functions

=Percentile() — specify ranking and return a value.

=PercentRank() — returns percentage based on specified
value.

=Quartile() — returns value of cell range based on specified

variable that divides distribution into four groups with

equal frequency.

=Rank() — returns value base on the specified rank.

g

Transform the data !
Formula Tab & Functions

» Date functions- for analyzing data
=Today() — displays current date

=Now() — displays current date and time

=Date(Year, Month, Day) — date displayed based on
arguments

=Days360() - calculates # of days between two dates
based on 360 calendar
=NetWorkDays(StartDate,EndDate,Holidays) — calculates
number of work dates using specified dates

=Year(Date) — returns year portion of a date

=Month(Date) - returns month portion of a date

10
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Formula Tab & Functions
» Text Functions
=LEFT() — returns leftmost characters of cell.
=RIGHT() — returns right most characters of cell
=MID()- returns specified number of characters
of a cell
=PROPER()- capitalizes first character of each
word in a cell.
Advanced Excel 2010 R |

| Transform the data ! Formula Tab & Functions

These functions calculate a range of cells based on ONE set of
conditions

=Sumlf() — sum data if it meets defined condition
=Averagelf() — count values if they fall within specified
conditions

=Countlf()- count values if they meet specified conditions

Advanced Excel 2010 R |

Transform the data ! Formula Tab & Functions

» Calculate values based on multiple conditions conditionally
=SumIFS()- Adds the cells in range which meet multiple criteria

=CountIFS() - Applies criteria to cells across multiple ranges and counts
the number of times all criteria are met

=AveragelFS()-Returns the average (arithmetic mean) of all the cells in a
range that meet a multiple criteria

Excel 2010 allows ability to calculate with multiple
conditions — up to 127 cell ranges and conditions

11
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Transform the data !
Formula Tab

» * Conditional Formulas - If Statement
Evaluate conditions with the If Statement Function —
allows user to evaluate a condition in another cell or range of
cells and place result in another cell.
The logical test or condition something that may be
evaluated True or False. Syntax is: = If(Logical Test, Value if
True, Value if False)  IF(N3 >100, N3,0).

Requires one of these comparison operators: =
<>, >, ,>=, <=,

03/18/2013
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‘ Transform the data ! Formula Tab

» Multiple If Functions
Nest up to 255 If statements to evaluate more than one
condition
Type closing parenthesis for each If statement in nesting.
IF(N3<100,N3*0.25+N3,IF(N3>100,N3*0.75-N3,0))

— If Functions with Multiple AND Conditions — AND allows you
to test for multiple conditions and return a TRUE result if ALL
conditions in function met. analyzing Data using

— If Functions with Multiple OR Conditions —  OR allows you
to test for multiple conditions and return a TRUE result if ONE
of the conditions met

Advanced Excel 2010 b |

Transform the data ! Formula Tab
» =Is Error function

Use with If Statement Function to replace error messages
IS functions, http://office.microsoft.com/en-us/excel-help/is-functions-HP010342632.aspx
TIP Use Excel online for help with functions by using the insert function option

12
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Transform the data !
Formula Tab
» — VLookup function—look up or retrieve data which exists in a

list in different area of the workbook or another workbook

Quick Reference Card: VLOOKUP refresher, http://office. microsoft.com/en-us/excel-
f d-viook f

I her-HA101873816.aspx

VLOOKUP Rafresher

03/18/2013
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‘ Innovative transformations of the data

»' Developer Tab

Save time by automating routine data actions with a Macro
Macros are a set of instructions based on actions taken while working
with worksheets and workbooks
Record the repetitive actions with a macro for future use
Saves time and streamlines work.
Store macros in personal macro workbook, *.xIsb file, so
they are available in all workbooks
Unhide personal macro workbook to access personal macro workbook.
«  Online Course for Macros - http://office.microsoft.com/en-us/excel-
help/save-time-by-creating-and-running-macros-in-excel-2010-
RZ102337714.aspx

Advanced Excel 2010 bt |
Innovate with automation

* Macros
Use macros to automate things you do routinely such as
adding your name to a document or formatting data

Quick access to saved macros
from Quick access toolbar or
custom ribbon

13
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